# Table of Contents

1. Objectives ........................................................................................................................................ 1
2. Introduction ...................................................................................................................................... 2
3. Chapter 1 – Basics
   - HCC Intranet compared to OneDrive for business? ................................................................. 3
   - Team sites benefits ..................................................................................................................... 4
   - SharePoint basics for intranet ................................................................................................... 5
   - Team site pages .......................................................................................................................... 6
   - Best practices for team sites .................................................................................................... 7
   - Accessibility ............................................................................................................................... 8
   - Hands On! - Recommendations to use this tutorial ............................................................... 9
4. Chapter 2 – Navigating to the HCC Intranet
   - User interface & navigation ..................................................................................................... 10
5. Chapter 3 – HCC Intranet overview
   - Home page ................................................................................................................................ 12
   - Team site layout ....................................................................................................................... 13
   - Get started box ....................................................................................................................... 14
   - Site Contents ........................................................................................................................... 14
6. Chapter 4 – Adding files
   - Adding files ............................................................................................................................... 15
7. Chapter 5 – Creating and sharing a subsite
   - Creating and sharing subsite .................................................................................................. 16
8. Chapter 6 – Adding libraries and lists
   - Adding Libraries and Lists ..................................................................................................... 19
   - Microsoft Support Video ......................................................................................................... 20
   - Adding a document library ..................................................................................................... 21
   - Adding a list .............................................................................................................................. 23
9. Chapter 7 - Customize your HCC Intranet team site
   - Customizing your HCC Intranet team site ........................................................................... 25
   - Microsoft Support Tutorial .................................................................................................... 26
   - Remove the getting started tiles ............................................................................................ 27
   - Remove the site feed ............................................................................................................... 27
   - Add the getting started tiles and site feed ............................................................................ 28
   - Changing the layout ................................................................................................................ 29
   - Add a welcome message to your home page ....................................................................... 30
   - Move the documents storage container to the page left side ............................................. 30
   - Change the title of the documents library ............................................................................ 31
   - Add links to your employee OneDrive for business folders .............................................. 32
10. Chapter 8 - Change your subsite appearance
    - Themes ....................................................................................................................................... 33
    - Promoted Links ....................................................................................................................... 34
11. Calendar/Meetings App .................................................................................................................. 39
12. Additional video training – Atomic Learning .................................................................................. 44

## Appendices

- **Appendix A** Set up Office 365 file storage and sharing
- **Appendix B** Set up Office apps on your tablets and phones
Objectives

Upon completion of this training participants will be able to:

1. Create a basic HCC Intranet team site (SharePoint site)
2. Add files to a team site
3. Add libraries and lists to a team site
4. Share the team site with others
5. Explore few elements of how to customize the team site
Introduction

HCC will use the HCC Intranet (SharePoint Team Sites) to store, organize, share, and access documents and information. With the HCC Intranet, users can "Work anywhere, anytime, on any device; all you need is a web browser."

This training is for HCC Intranet administrators and subsite owners.

HCC Intranet administrators are individuals designated to oversee the HCC Intranet team sites defined by the HCC Administration. Generally, they have some technology skills and know or follow instructions on how to store and share the files of their department or unit. Cabinet members, deans, directors, and certain managers appoint the HCC Intranet administrators.

Each HCC Intranet administrator designates the HCC Intranet subsite owners.

HCC’s Intranet administrators and subsite owners have a special and important role moving, organizing, and sharing the files that will be part of the HCC Intranet.

This training will concentrate on the steps to access and navigate the system, and some best practices to consider when setting up the sites and subsites.

This training covers the following areas of important focus:
- HCC Intranet Vs. OneDrive @ HCC
- Team sites best practices
- Team sites basics and navigation
- Team site creation and sharing

Office 365 is the Microsoft cloud-based service. At HCC, this includes SharePoint online. Through Office 365, HCC users have access to:

1. Microsoft Office tools (Word, Excel, PowerPoint, OneNote, Sway, and Class Notebook),
2. OneDrive (SharePoint to store and share files one-to-one),
3. Team Sites (SharePoint to manage intranet), and
4. Newsfeed (SharePoint social network).
Basics

HCC Intranet compared to OneDrive @ HCC?

You may be familiar with OneDrive@HCC, it has been available to the HCC community since 2014. If you are using OneDrive@HCC, you may find similarities with the new HCC Intranet.

Your Team Site is a place where you and your teammates/co-workers share files and information. Everything in your team site is accessible by your teammates and anyone else who has permission to view that site. **By default, every HCC employee have view rights of all document stored in the HCC Intranet’s parent sites.**

Some sites and subsites that may contain sensitive/protected information will have a restricted access (like some subsites for finance or HR).

The team site administrator can also create or authorize teammates to create other subsites with restricted access that may have view and/or editing rights only for a particular group of employees.

OneDrive@HCC is also a place where you can store, share, and synchronize your files to other devices, but if you want to share your files with others, you have to do it on a case-by-case basis. To find OneDrive@HCC training click [here](#).

For more information, see [should I save my documents to OneDrive for Business or a team site?](#)

Go to TOC
Team Sites Benefits

The *HCC Intranet*, also called *SharePoint Team Sites*, offers the following benefits:

1. Apps.
2. Collaboration. The intranet can be used as a repository to share and collaborate in files. It also includes great tools for work management like workflow, project sites, team sites, and others.
3. Search. Every file is indexed, meaning the files content is identified to create tables (indexes) that point to the location of folders, files and records. In few words, when you search for a word in the Intranet, the results will include every file (document, video, etc.) that contain that word in its title, content, or metadata.
4. Content Management. You can organize your files using libraries and/or sites. You can define who has access to the files and if each group or person has editing rights, viewing rights, or both.
5. Business Intelligence. SharePoint includes tools that can help you with your data analysis.
6. Business Solutions
7. Calendars for organizational units. You can create calendars for each team site or team project to track and control activities, share activities, etc.
SharePoint Basics for Intranet

SharePoint is like Legos. You have different pieces to build your project for the purpose you choose. You can build an Intranet, organize, share, and access information from almost any device, as well as many other things. You only have to take the pieces SharePoint provides and put them together the right way to achieve the desired result. A SharePoint site is an empty container that needs to be filled.

A site collection is a group of sites together and includes a parent site as well as all the different subsites that you can access from the parent site.

In a SharePoint site, everything is a list or a library.

A list is a table of contents like you would create in Excel, but you have more control on the different columns you build, plus all the other advantages that come with the fact that this is all online.

A library is similar to a list, but instead of just a list of elements in the table, you will find documents you downloaded in SharePoint like PDFs, PowerPoint, Word documents, etc.

SharePoint does not start you with an empty site from the beginning. You start with a template that includes lists that you might need depending on the type of site you choose when you create it.
Team Site Pages

There are many things you can do to create or change the site. You can create new pages, update content, and insert files and images using the tools available at the team site.

Everything you can view or click and open is a page. A team site is like any internet site. It is a collection of pages where every page is a web page, and all of them are interconnected. Pages can be a calendar, a list of documents, team discussions, information about an event, etc.

In a SharePoint team site, you will have three kinds of pages:

1. **System pages**: pages you cannot change
   System pages provide you with tools for working in the site. The tools include site content, site permissions, site settings, etc. You can use the tools, but you cannot edit them, add pictures or links, or change the layout. Usually the tools are in the layouts folder. They don’t have edit buttons or edit options in the page menu or the settings menu (settings menu is the gear icon). They are un-editable pages.

2. **Web Part pages**: pages that you have difficulties changing
   Web Part pages are pages which can display an aggregation of information from other sources (it pulls in data). Can display many types of data including lists, other web pages, search results, or data received from other servers. All the content on your Web Part page is displayed using a Web Part. Web parts examples are a title in a text, the job descriptions from a document library, a task list, and the calendar.

   Web Part pages work well when you want users to view information in a page, but the users do not need to make many changes to the way that information is displayed. Examples include shared documents and calendar. To edit Web Part pages you need to go to the Page Tab or the Settings menu and select “Edit Page.”

3. **Wiki pages**: pages you can easily change
   Wiki pages are easily edited in the browser. Pages contain text, images, pictures, and links, as well as lists and Web Parts. They are useful for collaborating on projects. Wiki pages are the default page type in SharePoint team sites, and can be easily identified because they have an “Edit” tab.
Best practices for team sites

If you are a team site owner, it is a good idea to create a governance model to address your site’s policies, processes, roles, and responsibilities. Click the following link to review a best practices guide suggested by Microsoft.

https://support.office.com/en-us/article/Best-practices-for-creating-and-managing-team-sites-95e83c3d-e1b0-4aae-9d08-e94dcaa4942e#toc261949816

In this guide you will find:
- What is governance?
- Subsite creation
- Permissions management
- Information architecture
- Track versions
- Create workflows
- Define content types
- Audit Tracking
- Site lifecycle and retirement
- Navigation
- Search
- Roles and responsibilities
- Data protection

Go to TOC
Accessibility

Section 504 and 508 of Rehabilitation Act (1973 and amendments), the Americans with Disabilities act 1990/2010, says that webpages and web content need to be accessible for individuals with a disability. When creating a webpage or online material you need to make sure that your pages and materials are accessible to individuals with print disabilities or hearing impairments. This can be easily accomplished in the Office program(s) or portable document format (PDF) using the accessibility tools that are in the program. They are easy to use, especially when you are creating the content. If you are using a webpage creation program, most programs have an accessibility checker within the program. Contact George Irwin at 259-6533 if you have a question or need a demonstration.

You want everyone to be able to use your SharePoint site, including people with disabilities. To learn more about creating an accessible SharePoint site, click https://support.office.com/en-US/article/Accessibility-features-6BD45F08-4002-4261-A18B-F28A944E49B6 and https://support.office.com/en-US/article/Get-ready-Build-an-accessible-SharePoint-site-3A1DF3AD-F093-450C-85A6-B3BF70FD6ABB

Web Accessibility Tools

Web accessibility evaluation tools are software programs or online services that help determine if a Web site meets accessibility guidelines. While Web accessibility evaluation tools can significantly reduce the time and effort to evaluate Web sites, no tool can automatically determine the accessibility of Web sites or realistically "certify" accessibility.

WAVE

WAVE is a free web accessibility evaluation tool provided by WebAIM. It is used to aid humans in the web accessibility evaluation process. WAVE shows the original web page with embedded icons and indicators that reveal the accessibility of that page. You can enter a URL on the WAVE webpage and it will show you the page you entered with its evaluation layered on top. There are also toolbars for browsers and Dreamweaver if you would like to have it on hand.

Other accessibility evaluation tools

Find other accessibility evaluation tools at the following links:
- Compilation of evaluation resources by Jim Thatcher
- Web Accessibility Evaluation Tools (W3C)
Time to start working on your Team Site - Hands on!

To obtain better learning results from this tutorial and make it more fun and interactive, follow the instructions applying each of them to your HCC Intranet team site.

The following chapters include a system demonstration, a video tutorial, and step-by-step instructions.

You can move between the resources using the "Next/Back buttons" or the "Drop Down menu".

The software demonstrations and the video tutorials include a control menu to pause, move forward/backward, or stop as many time as required by you. Learn at your pace and apply what you learn on the test team site or your team site.

Go to TOC
User Interface & Navigation

A software demonstration of “how to navigate to the HCC Intranet” is available at http://citt.hccfl.edu/pdws/PDWS_Content/Microsoft/HCC Intranet HTML Navigating/index.html

To access the HCC Intranet, open a browser and type hccfl.sharepoint.com. It is recommended that you bookmark this page. SharePoint functionality works better when using Internet Explorer (IE).

If you are logged in the HCC network, browsers like IE, Chrome, and Safari recognize your credentials from the HCC log in system. Click on your email address.

For other browsers, like Firefox, type your full HCC email address in the User name box and leave the Password box blank. Depending on the browser that you are using, you may be required to enter your NetID credentials.

**We recommend accessing your HCC Intranet and experiencing its functionality at the same time you follow this module.**

The HCC Intranet Home page opens.

Go to TOC
To access the other Office 365 tools, click the nine dots square located at the top left corner.

You will see squares in the middle of the page. Three of those squares are Newsfeed, OneDrive, and Sites. They are entry points into SharePoint. The other squares are shortcuts to Office online software.

- **Newsfeed** is the enterprise social network. You can use it to stay tuned into conversations among your coworkers and updates about their activities.

- **OneDrive for Business** is your personal document library—the place to keep your work documents and other files. When you store your files on OneDrive for Business, only you can see them. However, you can easily share them with coworkers and access them from your mobile device.

- **Sites** are used to easily find and access sites you are following, and quickly create new team sites.

*To go back to the HCC Intranet, click the Sites box.*
Home Page

The “HCC Intranet overview” software demonstration is available at http://citt.hccfl.edu/pdws/PDWS_Content/Microsoft/HCC Intranet HTML Overview/index.html

You will find boxes in the Home page of the HCC Intranet. These are the HCC Collection Sites that have been established college-wide. Under each of these collection sites, you will find subsites. The structure is like a tree with branches.
Team Site Layout

The team site has a logo, title, and navigation links. On the home page you have the Getting started boxes, News feed, and Documents.
Get Started Boxes and Site Contents

The “HCC Intranet subsites” software demonstration is available at http://citt.hccfl.edu/pdws/PDWS_Content/Microsoft/HCC Intranet HTML Subsites/index.html

Once you get to your new site, the Get started boxes are shortcuts to create or modify different things in your site including your branding, your design, your apps, etc.

To start creating your new site, click on any of the shortcuts or click on the Site Contents link, located at the bottom of the left navigation menu.

In the Site Contents page, you will see a summary of all the elements that you have in your site. At this page, you can add new subsites, pages, or documents. These alternatives will be reviewed in the following pages.
Adding Files

The “HCC Intranet uploading files” software demonstration is available at http://citt.hccfl.edu/pdws/PDWS_Content/Microsoft/HCC Intranet HTML Documents/index.html

You can start adding files by clicking the Documents link located in the left navigation links. This is call a document library. Here you can create, upload, edit, and share files or synchronize them to your computer.
Creating and sharing a subsite

The “HCC Intranet Subsite Sharing” software demonstration, is available at http://citt.hccfl.edu/pdws/PDWS_Content/Microsoft/HCC Intranet HTML Sharing/index.html

You can set up a team **Subsite**, which is like a private website, for file sharing and collaboration. By setting up subsites with unique permissions, you control who gets an invitation to access the subsite, reducing the risk that you might accidentally share files intended for one with another.

To create subsites for storing files:

1. At your team site, choose **Site Contents** and click **new subsite**.

2. At the **Site Contents > New SharePoint Site** page, in the **Title** box type a name for the subsite. The user will see this title.

3. For **Web Site Address**, in the **URL name** box, specify a name to appear in the URL for the subsite, such as the subject. The user will see this, too.

4. In **Template Selection**, accept the defaults.

5. For **User Permissions**, choose **Use Unique permissions**.

**Note:** This is the easiest option to use.
6. For **Navigation Inheritance**, choose **No**. By doing so, the subsite does not inherit navigation from your team site. Then choose **Create**.

![Navigation Inheritance](image)

7. At the **Set up Groups for this Site** page, add the names of the members you want to contribute to this -, and click **OK**. (In the example screen shot, Ivan Mesa is the site owner. Your name will appear on this page instead.)

You can select the rights for each member by adding them to three different categories: Visitors, Members, or Owners.

You can use a group previously created or create a new one.

![Set up Groups for this Site](image)
8. You have three options for adding members:

- Type the names and click **Check Names**. You may receive an error message if you have typos.

- Browse the Directory and add members.

- After you have created the site, you can share it using the Invite link at the bottom or the share link at the top right.

**Tip:** If you do not add any team members, your name, the site owner, should be the only one listed. You can store **private files** only you can access.

Go to TOC
Adding Libraries and Lists

Now you should be familiar with the basic elements of the HCC Intranet. In the following chapters you can learn how to start taking advantage of more advance HCC Intranet tools and features.

If you outgrow the default documents library, it is easy to add more storage containers to your team site, it is like what you do with the folders and sub-folders in your computer, you group the files in folders and name the folders so the files are easy to find.

The video tutorial in the following page will give you a good summary of what we have cover in the previous chapters, explains how to add document libraries and lists, and includes the instructions of how to customize and change the appearance of your HCC Intranet sites and subsites.

*The video tutorial includes a control menu to pause, move forward/backward, or stop as many time as required by you.*

*We recommend accessing the HCC Intranet and apply the instructions into the test team site or your team site at the same time you follow the instructions on the next pages.*
Microsoft Support Video

Click the following link to review the video “Setting up your team site for storage and sharing” (8:48 minutes). The video includes the basic steps to start building your site. It is located at the Microsoft support website.

https://support.office.com/en-us/article/Customize-your-team-site-06bbadc3-6b04-4a60-9d14-894f6a170818

The original Microsoft video is business oriented. The content on these pages has been adjusted to meet HCC’s needs. Continue reading the next pages to see the step-by-step tutorial, that is similar from the video, but specific to HCC, including:

- Team Site layout
- Adding a document library
- Document library – Adding files
- Adding a list
- Customizing your HCC Intranet team site
  - Removing and adding the Getting started tiles and the Site Feed
  - Changing the Layout
  - Adding a welcome message to your Home page
  - Moving the Documents storage container to the left side of the page.
  - Changing the title of the Documents library
  - Adding links to your employee OneDrive @ HCC folders
  - Setting-up a Subsite for sharing files with specific users
  - Changing your Subsite Appearance
Adding a document library

If you outgrow the default documents library, it is easy to add more storage containers to your team site. First, determine how you want to group files on your team site and what you want to name the storage containers so the files are easy to find. You can create additional document libraries for different purposes.

1. There are different ways to get to the same place to add an App and create the new document libraries:
   - at the home page click Add libraries (Get started box), or
   - at the site contents page click add an app, or
   - at the gear click Add an app

2. Select Document Library, enter a name, and click create.

Go to TOC
3. Now you can see your new library at the **Site Contents** and under the **Recent** navigation links list on the left.

4. To start creating or uploading files to this library, click on the **box** or the **link**. Then click **New** or **Upload**, or just **Drag and drop** the files.

5. To delete a document library, hover over the tile for the library, choose the **More** button ( . . . ), and then choose **Remove**.

6. To rename a document library, choose **Settings**, and then choose **List name, description, and navigation**. In the **Name** box, type a new name, and choose **Save**. Choose **Site Contents** so you can continue adding more document libraries.
Adding a List

You can add other types of apps like lists. A list stores and organizes data. Lists are grouped into two main categories:

- **Tracking** includes calendar, tasks, links, project tasks, issue tracking and survey.
- **Communications** includes announcements, contacts, and discussion boards.

1. Again, there are different ways to get to the same place to add an App.
   - at the home page click **Add libraries (Get started box)**, or
   - at the **site contents** page click **add an app**, or
   - at the **gear** click **Add an app**

2. In this example we are going to add a list app for **Contacts**. Once the Apps page opens, select **Contacts**, type a name, and click **Create**.

Go to TOC
3. Choose + New item to add a contact.

4. Enter the information for your first contact. You can enter information in some or all of the boxes. Choose Save when you are done.

5. By default, Last Name, First Name, Company, Business Phone, Home Phone, and Email address appear on your contacts page.
Customizing your HCC Intranet team site

At this point you should feel more comfortable using the HCC Intranet. If you want to personalize and change the appearance of your team site, you can learn more advance tools and features in the following chapters.

The tutorial in the following page explain some of the material covered on the previous Microsoft video tutorial, using a different format (text and screen shots), and is focused on the instructions of how to customize and change the appearance of your HCC Intranet sites and subsites.

*We recommend accessing the HCC Intranet and apply the instructions into the test team site or your team site at the same time you follow the instructions on the next pages.*

Go to TOC
Microsoft Support Tutorial

You can customize your team site to help you and other employees quickly access needed information. For example, you might have a link to the employee OneDrive@HCC folders, and links to Documents, Contacts, Tasks, Calendars, and a OneNote notebook (where you store meeting agendas and notes).

To see the original Microsoft tutorial, click the following link:


The original Microsoft tutorial is business oriented. The content on these pages has been adjusted to meet HCC’s needs. Continue reading the next pages to see the step-by-step tutorial, that is similar from the video, but specific to HCC, including:

- Removing and adding the Getting started tiles and Site Feed
- Changing the Layout
- Adding a welcome message to your Home page
- Moving the Documents storage container to the left side of the page
- Changing the title of the Documents library
-Adding links to your employee OneDrive @ HCC folders
- Setting-up a subsite for sharing files with specific users
- Changing your subsite Appearance

Go to TOC
Remove the Getting Started tiles

Now that we are done using the Get Started boxes, we are going to remove them from the Home page (we will show you how to put it back at the end of this section). This does not mean we cannot keep customizing the site. All team site customization is still available from the Edit menu and Site Settings area of the site.

Click Remove this to get the Getting Started boxes out of the way. Then click OK.

Remove the Site Feed

Click on the drop menu arrow in the Site Feed box, and press Delete to remove it. Then click OK.

Go to TOC
Add the Getting started tiles

1. On the Home page of your team site, choose Edit.
2. Choose Insert > Web Part > Media and Content > Get started with your site > Add.
3. Choose Save at the top of the page.

Add the Site Feed

1. On the Home page of your team site, choose Edit.
2. Choose Insert > Web Part > Media and Content > Get started with your site > Add.
3. Choose Save at the top of the page.

Your team site will look similar to this.
Changing the Layout

1. At your team sites Home page, you have two options to get to the same place:
   - At the top left side choose **Page > Edit**, or
   - At the top right side click **Edit**

2. The **Format Text** menu will appear. Click **Text Layout** and make a selection.

3. **Three columns with header and footer** will give you the most options for your page layout.
Add a welcome message to your Home page

Make sure you are in **Edit mode**. In the top box, **type** a welcome message. Choose the **Format Text tab**, and then use the font controls to **format the text**. (If you see a message about not being able to display the web part, ignore it.) Click **Save** when you are done.

![Format Text tab](image)

Welcome to the PDWS (Professional Development and Workshop Services) internal site!

Move the Documents storage container to the left side of the page

It is helpful to do this because most people look at the left side of a page first.

**Drag and drop** the Documents box to the left side of the page. The box might be tricky to grab, and moving it might take you a few times. (If you see a message about not being able to display the web part, ignore it.)

![Documents container](image)

Go to TOC
Change the title of the Documents library

Choose **Edit Web Part** from the **drop down menu**. In the box on the right side of the screen, Expand the **Appearance section**. In the Title box, type **Team Documents**. Scroll down, and choose **OK to save**.

Go to TOC
Add links to your Employee OneDrive@HCC Folders

1. While still in edit mode, in the empty box in the middle of the Home page, add a heading for the links to your employee OneDrive@HCC folders. Use the menu at the top of the page to format your text.

2. Under the heading you just added, list the names of your employee OneDrive@HCC folders, naming them so they are easy to identify.

3. To make the folder names a link, Highlight the name of an employee’s OneDrive@HCC folder.

4. From the Insert tab click Link, and then select From Address.

5. Enter the URL for an employee’s OneDrive@HCC folder, and choose OK. You can create the URL using this format: https://hccfl-my.sharepoint.com/personal/imesa2_hccfl.edu.

6. Save, when you have added links for all of your employees.

7. After doing this, your team site Home page will look similar to this example, with shared documents on one side of the page and links to employee’s OneDrive@HCC folders in the middle.
Change your Subsite Appearance

Themes

If you create many subsites, it can be useful to have each one created with a different theme. An easy way to make the subsite look different from your internal site is to change the theme. Choose Settings > Change the look to try different themes for the subsite.

Go to TOC
Promoted links

You can make your team site look professional and easy to navigate by adding colorful tiles or icons that link to important pages on your site. If you want, you can link to other external websites too. These links are called promoted links because the icons or tiles draw attention to them.

1. Download the images onto your computer.

2. On your team site, in the left navigation, choose Site Contents. Then choose Site Assets.

3. Use Windows Explorer to upload the images to the Site Assets library. Open Windows Explorer. Navigate to the folder where you stored the images. Choose all five images and drag them to your Site Assets library.
4. To associate the images and links together, you need to compile a list of the locations (URLs) of both. An easy way to do this is to copy the locations into Word or Notepad. By doing so, you will have them readily available when you are later prompted for the locations.

5. Go to the Site Assets library. **Click on each image**, and once it opens **copy the URL**. Do this for all of the images. Make sure it is a URL ending as “.jpg”.

6. Copy and paste all of the URLs for the pages on your team site that you want to use as links. For example, go to your Committee members’ page, and copy that URL. In the end, you should have a list of the image URLs and the corresponding pages.

7. On your team site Home page, choose **Site Contents > add an app**. Scroll down, and choose **Promoted links**.

8. For the purpose of this example, name your links **Top Tasks**, and choose **Create**. When you are finished with this tutorial, the title of your promoted links app (Top Tasks) will appear on your Home page, where we put the promoted links.
9. Choose the **Top Tasks library**. The page will be empty. Choose **All Promoted Links**.

10. Choose **+ new item** to add an image and link. Here is where you need your list of images and links in Word or Notepad.

11. In **Title**, type a name that will appear on the tile. For example, type **Committee Members**.

12. Go to your Word or Notepad file and copy the URL for the image that you want to use for Vendors and Suppliers. Paste it into the **Background Image Location** box.

13. Copy the URL for the page you want to link to, and paste into the **Link Location** dialog box.

14. In the **Launch Behavior** box, choose whether you want to launch a new tab when the icon is clicked (recommended for links that go to external websites) or stay in the current instance of the browser, which is in-page navigation. Choose **Save** when you are done.

Go to TOC
15. Click the **new item** link located under the Top Task title or click the **New Item** icon under the **Items** tab. Repeat steps 11 to 14 until you have linked all of the images and pages.

16. To see what your tiles look like, choose **List > Current View > Tiles**.

17. To change the order of your tiles, or make other changes, click the **edit** link located under the Top Task title. Use the **Order** column to specify the order of your tiles. Choose **Stop** to save your changes.
18. On the **Home** page of your team site, choose **Edit**.

19. Place your cursor at the end of your Welcome message, and press Enter. Your cursor should still be in the same box.

20. Choose **Insert** > **Web Part** > **Top Tasks** > **Add**.

21. Choose **Save** at the top of the page.

22. Your team site will look similar to this.
Calendar/Meetings App

Although SharePoint includes a calendar in its default apps, there is a more functional custom site that will allow you to post not only meeting dates, but also agenda items for each meeting.

As a site administrator, you would install this subsite like any other, but use the Custom tab to find the Meetings subsite template. If you need detailed instructions about creating a subsite you can revisit chapter five.

1. Create a new subsite clicking the Site Contents link, and then the new subsite link.

2. Give your site a Title and a URL address. If you will have only one Meetings subsite in your site, it is recommended to give the site the title of Meetings.

   In the Permissions and Navigation Inheritance, accept the defaults.

   Click Create.
3. After the site is created, you will have a new **Meetings** subsite with two lists: A **Calendar list** and an **Agenda list**. The site will also have some default pages to show the **Next Meetings** and its agenda items, **Future Meetings** agenda items, and **Past Meetings** agenda items.

4. Please note that **meetings must be entered before agenda items** can be entered for those meetings. To enter a new meeting, click **+ new event** this will display a data entry form.

5. Enter your values and click **Save**.

6. After the meeting is created, you will see it under **Next Meeting**.

7. Now **Agenda Items** can be entered for the meeting. To enter a new agenda item, click **+ new item**, this will display a data entry form.
8. Enter your values in the new **Agenda Item** entry form. Agenda items must have a subject, a name (owner), and be assigned to an existing meeting date. The other fields are optional. Click Save at the top left of the form when the data is entered. Agenda items can have outcomes that can be tracked and assigned to people with a due date. This would usually occur after the agenda item is discussed in a meeting.

9. When you complete the agenda items form and click **Save**, a confirmation message will pop up, click **OK** to finalize the agenda item creation.
10. When agenda items are assigned to a person and have a due date, that due date will show up on the calendar that is displayed on the Meetings and Due Dates page. Meetings are displayed in blue, and due dates are displayed in green.
11. To edit an existing agenda item, go to **Next/Current Meeting**, open the item clicking on the **Subject**, and click the **Edit Item** button in the top left.

![Image of Next/Current Meeting page](image1)

12. To edit an existing meeting, click its title on the **Meetings and Due Dates** or the **Next/Current Meeting** page, and then click **Edit Item** in the top left menu.

![Image of Office 365 and Sites page](image2)
Atomic Learning

Find additional video tutorials in the Atomic Learning library. For access instructions to this library please click the following link:
http://citt.hccfl.edu/pdws/PDWS_Content/Microsoft/Windows%207/Atomic%20Learning%20Access%202014.pdf

For the Basic Level, the following video tutorials are recommended. These tutorials are located under SharePoint Online – Basic Training (log in at the top right menu before you start watching):

1. What's New?
   a. Moving around in SharePoint
   b. Exploring the Newsfeed feature
   c. Using the Drag and Drop feature
   d. Understanding libraries
   e. Understanding lists
   f. Changing the view and sorting information
   g. Using the recycle bin
   h. Using help

2. Document Libraries
   a. Creating a new document in a library
   b. Creating a new folder in a document library
   c. Uploading a single file to a document library
   d. Uploading multiple files to a document library
   e. Opening a file in a document library pt. 1
   f. Opening a file in a document library pt. 2
   g. Checking out a file
   h. Checking in a file pt. 1
   i. Checking in a file pt. 2

3. Picture Libraries
   a. Using picture libraries
   b. Uploading a single picture to the library
   c. Sharing pictures
   d. Changing the picture library display

4. Calendars
   a. Adding a new event/creating an all day event
   b. Creating a recurring event

5. Contact List
   a. Adding a new contact to a contacts list
   b. Viewing Contact properties
   c. Editing a contact

Go to TOC
To learn additional basic level features view the following video tutorials, located under SharePoint Online – **Getting Started**:

1. Getting Started
   a. [Basics of working with document libraries](#)
   b. [Uploading documents to SharePoint online](#)
   c. [Basic calendaring](#)
   d. [Custom lists](#)
Appendices

Appendix A  Set up Office 365 file storage and sharing
Appendix B  Set up Office apps on your tablets and phones
Appendix A

Set up Office 365 file storage and sharing

Source: Microsoft support website

One of the best ways to set up file storage and sharing for your department is to use OneDrive @ HCC and the HCC Intranet together.

You can store files in OneDrive @ HCC and collaborate on files in your team site located in the HCC Intranet. Access the link below to learn more about file storage and sharing.


In this article
- Where you can store documents in Office 365: Learn when you should use OneDrive @ HCC to store files and when you should use the HCC Intranet team sites.
- Video - How to move files to Office 365 and sync across devices (3:40): See how easy it is to upload files in OneDrive @ HCC and your HCC Intranet team site.
- Start using OneDrive for Business and a team site for file storage and online collaboration: Get all the steps for uploading files to OneDrive @ HCC and your HCC Intranet team site. Learn tips for file sharing.
Appendix B

Set up Office apps on your tablets and phones

Source: Microsoft support website

Office apps allow you to edit files that are stored on your HCC Intranet team site from your tablet or phone. If you do not install the Office apps for your tablet or phone, you will be able to view the files on your HCC Intranet team site but not edit them.

- Install and set up Office on an Android with Office 365
- Install and set up Office on an iPhone or iPad with Office 365
- Set up Office on Windows Phone with Office 365